Welcome

In this first issue we will chart our journey so far and
give you some glimpses behind the scenes. We even
have an interview with the head dev of the Affinity
team.

...to the first issue of Affinity Review!

We will also focus in-depth on the Affinity Designer
app, with a special Feature Focus on the Pen Tool
and give you some cheat sheet pull outs for the
shortcut keys that you need to know.

It has been an amazing journey here so far working
on Affinity. After 4 years, a few million lines of code
and an incredible response to our public beta, we
launched our first app, Affinity Designer on the 2nd
October 2014.
We have been overwhelmed by all your support. At
the end of our launch week, we were #1 on the Mac
App Store worldwide, had over 400 5-star reviews,
got featured AND were the Editors’ Choice! Finally
we came runner-up in Apple’s Best of 2014 round up.
Not bad!
So welcome to the next step in our journey – Affinity
Review. This is our quarterly companion magazine
for the Affinity range of software, and this is our first
issue.

Plus, we have a special interview with one of our
designer contributors, the amazingly talented
Jonathan Ball from Poked Studios and a brilliant
tutorial from the one and only bubblefriends –
Sascha Preuß.
Ash Hewson
MD

AFFINITY UPDATE

As well as a recap of what we’ve
been up to, find out what’s to
come soon for Affinity...

Affinity
Update

AFFINITY UPDATE

Affinity – the story so far…
Serif had been developing Windows software for 25
years when about 4 years ago, our then Head of
Development, Tony Brightman, gave a presentation
of a new idea...
The idea, codename ‘Persona’, was to develop a
whole new range of professional graphics software
for Mac. These apps would be special in their
conception – built from the ground up for Mac with
the workflow of creative professionals in mind. He
wanted to create something that would set a new,
higher standard for creative design apps. His vision
set out the key criteria that this new range of apps
would have to be:

• Use exactly the same file format between
applications
• Have no bloat – a concept of ‘Personas’ would
be used to separate use cases in each
application’s UI
• Be unashamedly pro. Core requirements like
CMYK and 16 bit would be built in from the
start. Productive workflow for creative pros
always taking priority over accessibility for
novices
• Mac first, but relatively OS independent.
He said to give him a team of developers for 3 years
and we’d have launched the first product.

• Lightning fast

The response? “Ok Tony, go for it...”

• Never run out of memory

Boy are we glad we did. Nearly everything Tony said
that day is becoming reality…

• Cover the core creative disciplines of Photo
Editing, Vector Drawing and Desktop Publishing

… other than it only taking 3 years!
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But, credit where credit’s due, fact is we started from
scratch, and nearly every single component used in
Affinity has been written from the ground up. It’s
been R&D at its best – but that means lots of trial
and error, solutions to problems you thought would
take 2 weeks taking 6 months, writing 1,000s of lines
of code for something only to throw it away because
it didn’t work.

That’s just the way it goes when writing software,
especially when striving for perfection (and that’s
Tony’s favourite word by the way ;) ).

Coming up with the name...
With all the crazy mathematical and technological
problems which have been solved over the last few
years, without a doubt one of the things we found
the hardest was coming up with a name!
It got to a point that we asked everyone in the
company to come up with some ideas. We offered
an iPad as a prize for who came up with the final
name – and set up white boards that got filled with
hundreds of ideas. Every time we thought we had a
good one, there was some trademark or other
problem with it.

Affinity developer Andy Tang doing some R&D

The person who came up with Affinity? That was
Tony! He was actually using it for a codename of
another project when we realised how well it worked
for the ‘Persona’ range... he’s still waiting on his
iPad!
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One of the whiteboards we used to collect name ideas... we have blanked out the more offensive ones!

AFFINITY UPDATE

The Branding & Icons
In the early stages of ‘Persona’ we used the
placeholder icon shown, but it wasn’t until the name
was decided upon that we could really get to work
on the branding. For an App like ours, branding
primarily means the icons we would use. Neil Ladkin,
our Art Director, set to work on this and again turned
into nearly as contentious an issue as the name.
It was important to us to achieve an icon set that
would stand out in the crowd of apps on the App
Store, but also we were very keen to have something
about them which tied them together clearly as part
of the Affinity range. Loads of sketches and worked
up concepts were produced, many of which we
unfortunately no longer have...

The placeholder ‘Persona’ icon we used for the early builds
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A triangle became a common theme, echoing the angles of the ‘A’ of Affinity. One of the best developments
was when the triangle evolved into a more distinctive shape – with a few more angles and the small line below
it. This shaped worked as a monotone icon to use for the main Affinity branding, with the other icons taking on
that shape as part of their design.
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The Beta
In January 2014 we had a very early build of the first
app in the range, Affinity Designer. Our creatives
had been involved from the start with the
development of Affinity, and used this build for real
work – designing the UI, website concepts and other
graphics work for Affinity. Using it internally for real
work was invaluable to iron out the major quirks and
streamline some of the workflow.
We knew that it was going to be critical to get it into
real users’ hands, and so we decided to put it into
the public beta phase – to get some real users
involved and generate some awareness of the app
before we launched it. While Serif has been around a
long time and has a huge user base the fact was
that nearly all those customers were Windows users,
so we had to start at the beginning.
We set up our Facebook and Twitter accounts, and
tried to get a bit of press. That was pretty much our
marketing strategy. Our first big hit happened on
21st July when Creative Bloq announced the beta:
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We’ll be forever grateful to CB for that headline! It
went ballistic very quickly. All of a sudden Twitter
and Facebook were buzzing with the idea there was
finally a professional alternative to Illustrator on the
horizon.

Which Joshua Topolski retweeted:

We started getting picked up on other media sites
and bloggers started writing about us.
What really surprised us was the power of Twitter.
On the 1st August Khoi Vinh mentioned us:
With their followers and the retweets that ensued
we ended in the feed of nearly 1M twitter users that
day. What’s more we hit the top rank on the Hacker
News aggregator because of it and gained huge
traffic to our site.
We did try a couple of banner ads and other bits and
bobs but ultimately what it came down to is by the
time we launched on 2nd October we had only spent
around £2,000 on marketing but had more than
30,000 people who had downloaded the beta. A bit
of press and social word spreading completely
smashed all our expectations for the beta!
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Beta Period Web Traffic
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Beta Period Web Traffic Sources
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Launch Day – 2nd October
We chose a Thursday to launch Affinity Designer
because we knew that was the day that Apple
update their banners on the App Store – and so felt
it gave us the best chance to get featured by them.

Next thing to wait for was for when Apple updated
their featured banners on the App Store. We knew
that would happen at around midday California time
(8pm for us) and sure enough, at 7.30pm, we were
there:

Whilst we set it to go live on the 2nd, we weren’t
100% sure what time it would go live. We actually
got our answer at around 6pm UK time on the 1st
Oct – it was already live in Australia! Turns out it
goes live in the early hours of the date you have set,
but individually in each territory.
It took until around 8am in the morning until we
were live across the world. We put our website live
with buy links to the App Store, put up our posts on
Facebook and Twitter with our feature video, got the
press release out and sent an email to all of you who
had downloaded the beta to let you know we’d
launched.

Not just featured, but Editor’s Choice!! That was just
incredible.
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The week from then on is just a blur really. We
picked up some amazing press, but most importantly
so many of you shared our video on social media we
just couldn’t believe it. By the end of the week we
were the #1 Paid App worldwide, and had well over
400 5-star reviews.

An amazing week. We said it at the time, and we
want to say it again, such a big part of that week’s
success, and in fact all the success we’ve had since,
was down to you helping spread the word about our
product. “Thank You” doesn’t come close to how
grateful we are.
How to repay you? We are throwing everything we
can at continuing to take all your feedback on board,
developing new features and improvements to make
Affinity Designer the product you want it to be. We
have never been more motivated or excited, and will
not let you down!
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Affinity Designer Roadmap
Here are some things to look forward to that will be released as FREE updates:

Illustration & Design
•
•
•
•
•
•
•
•
•
•
•
•
•

Mesh Fill Tool
Mesh Warp/Distort Tool
Text on a path
Knife Tool
Line alignment
Calligraphic line styles
Symbols
Export slices previews with
export data
Pages and Art-boards
Text styles, bullets and
numbering
Dashed line styles
Knockout groups
Rounded Corner

Pro Printing
• Publishing PDF/X-1a, PDF/X-3,
PDF/X-4
• PDF image compression
• Trim and bleed control
• Overprint control
• Printer marks
• Pantone, Spot and Registration
colours
• Linked/global colours
• Tints of colours
• Named colours and palette list
mode
• Font sub-setting control
• Phase II transparency flattener

Usability
• Pasteboard design area
• Replicate/Blend
• Guides and grid
improvements
• User categories in the media
browser
• Customisable shortcut keys

If you have purchased Affinity Designer, why not join in on our beta forums? You
can try all the latest features and improvements that are in development!

AFFINITY UPDATE

Want to see one of features we have got coming up in a future FREE
update of Affinity Designer?
Affinity developer Matt has recorded a preview of the upcoming Corners feature.
The final feature won’t look like this, but shows how it works.
Keep an eye out on our beta forum to try it out before it goes live in the App Store!

19

AFFINITY UPDATE

Public beta starting soon....

AFFINITY UPDATE

Affinity Photo
We are very excited about what we will be bringing
you with Affinity Photo, and the public beta will be in
full swing very soon (though perhaps a little later
than planned!).
On top of the all the power and precision you can
expect from Affinity – here’s what ‘Personas’ are
coming your way in version 1:

The public beta will mean you can try Affinity Photo
for FREE and help shape its development by giving
feedback on the beta forums.
To be in the know when the full public beta starts,
and to get beta news updates, make sure you
sign up to our newsletter. We will also be releasing
some sneak peek videos of Affinity Photo on
Facebook and Twitter over the coming weeks, so
keep an eye out!

• Edit - Powerful photo editing tools
• Develop - Develop your RAW photos with ease
• Looks - Apply professional level looks to photos
• Liquefy - Manipulate by pushing, thinning, warping
• Export - Export multiple areas of your images

Sneak Peek - Inpainting Brush
One of the features of Affinity Photo that we are
really excited about is the Inpainting Brush. The first
glimpse of which is exclusively for Affinity Review
readers on the next page...
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First look at the upcoming Affinity Photo... Check out the Inpainting Brush!
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INSPIRATION

We commissioned the supremely talented
Jonathan Ball, aka pokedstudio, to create
some artwork for Affinity, plus the
stunning front cover for this issue of
Affinity Review!
Here we talk to Jonathan about his
creative practice and how he found
working with Affinity Designer...

Jonathan
Ball

INSPIRATION | pokedstudio

Did you always want to be a designer?
No. I wanted to be in a rock band, but that sort of
never worked out. I didn’t realise it could be a
realistic career until I was in my mid twenties.

Can you tell us how pokedstudio came into
existence? Can you tell us how the studio got its
name?
Ha, I get a lot of confusion from the name... It just
comes form the idea of when you are little you poke
stuff to see what it is. I remember wandering around
my garden and poking slugs and snails and other
slimy things.

Where do you get your inspiration?
There’s a lot of stuff sitting there in the back of my
mind, just waiting to be used. Lots of 80‘s TV shows
and video games, a bit of sci-fi and fooood.
Commissioned front cover for ‘Affinity Review Issue 1’
Created by Jonathan Ball in Affinity Designer

INSPIRATION | pokedstudio

You have worked for some big brands like MTV, BBC,
Playstation and Nickelodeon to name a few. What’s
been your favourite commission to date?
Do I have to say for Affinity Designer? ;) Well that
was a great one as you gave me a lot of freedom.
Some of the smaller commissions are actually the
best, as you get more freedom to push the work.
Though I’ve recently created some game packaging
for a big toy company that I can’t wait to see in the
shops!
‘Ms Pacman’ Created by Jonathan Ball in Blender

Does your creative process differ between working
on client commissions and your own artwork?
Yes, when I’m creating my own work I can be a lot
more flexible. With clients often the work needs to
be signed off at various stages, so its difficult to go
back and change things that aren’t working so well
when they have already been approved.

What’s been your most successful artwork you have
made for yourself?
Ms Pacman was a 3D illustration I made at the
beginning of my career. That brought me in a lot of
work and kickstarted things for me. It’s currently
being featured in a video game exhibition touring
France.
I can link a lot of commercial jobs I get to individual
pieces of work I created for myself.
25

INSPIRATION | pokedstudio

If there is one, what’s the story for ‘Space’?
Some crazy creatures in space, looking for some
cheese, but… it’s a trap…

Can you tell us how using Affinity Designer helped
you to realise ‘Space’?
My biggest surprise was how much better gradients
were in Affinity Designer. In Illustrator they are a real
headache! Also being able to rollover blending
modes to see how they will work. The fact that it
doesn’t slow down even when there’s loads going on
on screen…

My favourite of your Affinity work is ‘Mountains’.
How do you approach colour in your work?
Yes my favourite too. I try to mix small areas of
bright colour with larger more muted areas. This
helps colours pop and give contrast.
Detailed view of ‘Space’
Created by Jonathan Ball in Affinity Designer
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‘Space’
Created by Jonathan Ball
in Affinity Designer

‘Mountains’
Created by Jonathan Ball
in Affinity Designer

INSPIRATION | pokedstudio

Both ‘Space’ and ‘Mountains’ are incredibly detailed,
how long did it take you to make these?
I think they were made over the course of a couple
of weeks for each one… unlike some other artists I
tend to build detail as I go along, so my sketches are
pretty basic. When i get into the flow of creating a
piece I can see more clearly where to add details.
Detailed view of ‘Mountains’, by Jonathan Ball in Affinity Designer

Part of the ‘food!’ series of illustrations created for Vrij Nederland
Created by Jonathan Ball in Affinity Designer

I love the GameBoy character in ‘Mountains’, are
there references and motifs that you return to time
and time again in your work?
Yes there a lot of things I repeat... food and video
game icons are among the things you will regularly
find in my work.

You have some more work made in Affinity Designer
on your Behance profile, it’s witty and it made me
chuckle! Does your work ever make you laugh?
Yes, sometimes :) I have heard that as you get older
you tend to laugh less, so I try to make sure I have a
lot of humour in my work.
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Have you ever eaten horse? And do cucumbers have
feelings?
I may have eaten horse, but not deliberately, who
knows what’s in some food! Yes cucumbers are
alive, doesn’t everyone know this?
Tell us how you got on with Affinity Designer, thumbs
up or thumbs down?
Thumbs up all round. There are a few niggles I’d like
to see tweaked (better colour picker please ;)) . It’s
now a permanent tool for me. Expect more work
created in Affinity from me in the future.

Been a pleasure talking with you Jonathan, any final
words for us?
Burp!

Part of the ‘food!’ series of illustrations created for Vrij Nederland
Created by Jonathan Ball in Affinity Designer

> See more of Jon’s work @ pokedstudio.com
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BEHIND THE SCENES

We nipped next door to talk to the
main brain behind Affinity, Tony
Brightman – Head of Serif Labs.

Tony
Brightman

BEHIND THE SCENES | Tony Brightman

The Serif Labs team is focused on research and
development on a scale not seen before here at
Serif. How did the Affinity project start? Also, can
you tell us how the team came into existence, how
many of you there are and what you all do?
The project actually started out as a research project
headed by one of my senior developers – Andy
Somerfield. The aim of the project was to create a
memory management system capable of high-end
photo editing on an iPad with only 80MB memory
available to the App. The memory system was very
successful and demonstrated what we could achieve
given a clean slate, enough time and a clear
objective. The project then grew to include other
technologies such as raster pipelines, threading
architectures, asynchronous command processors
and serialization. By now the team had grown to
include Matt Priestley for all things vector, Justin Teo
for raster processing, Dave Harris for text engine,
Ben Idoine on serialization and Andy Tang for OSX
UI. We ended up with a perfect storm of skills and
experience to enable us to develop something very

special and I believe game changing. We spent
another 3 years in deep R&D and decided Affinity
Designer would be our first demonstration of the
new platform.

Who did you have in mind would be your typical
Affinity user? The tagline for Affinity Designer is
‘Professional graphic design software for the Mac’.
Firstly were you always certain you wanted to create
a pro end product and secondly, was your vision
always to be Mac only and if so, why?
I had spent 15 years developing software for the
consumer market and to be 100% honest I was
bored. I knew we had the collective skills and
experience to aim higher and with the consumer
market beginning to stagnate choosing the pro
market was an easy decision. The main difference I
see with professional software is that it has no upper
limit on usage.
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What I mean by that is performance, productivity
and stability of the product shouldn’t exclude its use
in a high-end professional context. I also don’t
believe pro software has to be any harder to use or
alienate beginners. We perhaps exclude a narrow
part of the consumer market, as we don’t offer
things like wizards or help panels as they just tend to
compromise the UI and water down our focus.
The decision to go Mac was also easy; the
professionals we wanted to attract are mainly Mac
owning designers and my new team were hungry to
explore the Mac world so it just felt like the right way
to go.

What have been the biggest challenges in
developing Affinity so far and what do you think the
biggest challenges in the future may be? Has failure
been a significant part of the process?
The hardest part has been the length of the R&D
phase of the project. The magnitude of the project
was massive and keeping everyone focused was

hard going. The technology was hard to develop but
the guys in the team are so good at what they do it
just seemed to fall out right most of the time. The
biggest challenge going forward is to complete the
vision, we have many years to go and another few
million lines of code to write but we are all
committed. We have had many setbacks but I
wouldn’t call any of them a failure and that’s just
what happens in R&D at this level.

How did you come up with the name?
The codename for the project was actually Persona.
The name described the idea of a central document
and multiple personas contributing to achieve a
common goal. I always liked the name Persona but
when we started looking at how we should market
the range then Affinity seemed like an apt name.
Having affinity with the tools you use to achieve your
vision seemed to resonate with most of us so Affinity
it was.
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Real-time footage of Affinity Designer flexing its rendering
engine muscles across 14.7M pixels on the new iMac Retina...
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Within 7 days of launch Affinity Designer was #1
paid app worldwide on the Mac App Store, Editor’s
Choice and had received over 400 5-star reviews.
Was this what you had expected to happen, or did it
take you by surprise?
I expected Affinity Designer to do well as we had
engaged with professional designers and had
already received fantastic feedback during the beta.
What I didn’t expect was the 400 5-star reviews. For
a version 1.0 product I had never seen this level of
engagement before and the whole team were so
pleased and proud of what we had achieved.

Is Affinity Designer finally the app that is fully
functional, intuitive AND is also looks wise
comparable to the ‘Delicious Generation’ of apps?
I hope so but I guess our users are the best judge.
The feedback feels very different to any other
application I have worked on.

For a version one, Affinity Designer is pretty feature
rich, though obviously there are some tools that are
missing for some users. Is this why you decided to
publish the development roadmap for the app? Also,
are we going to see some sort of vector trace, which
is not mentioned?
Because we want every feature to work just right
then the process takes a long time. We also wanted
to show everyone the direction we are taking and
involve them in the process. The feature roadmap is
our promise to keep adding features and improving
the product until we are happy with it. I’m really
pleased with the feedback we are getting and it’s
fun to engage with the passionate designers out
there who want Affinity to be the victor in the
professional world.
Autotrace is an interesting feature and I have been
involved in developing the feature before. The
problem is that the results are often very poor and I
don’t want poor features going into Affinity. If we
can surpass something like the fantastic Vector
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Magic then I would be happy to have Autotrace but
if it doesn’t then it will have to wait until we can.

Does Affinity Designer, and the other upcoming apps
in the range, have any kind of built-in support for
third-party extension or plugins? Do you expect/hope
for third-party additions?
We hope to extend Affinity by exposing its
functionality through macros and scripting. We have
already been working on macros for Affinity Photo
but we still have a way to go. As the community of
users grows we aim to support their desire to build
on Affinity’s features so it’s just a matter of time and
priorities.

Affinity Designer comes to market when Sketch is
killing it with UI designers, do you have any thoughts
about Sketch?
I think Sketch is a great little App. They are very
focused and have developed features that fit well for

UI designers. Affinity Designer’s feature set will grow
to encompass some of the subtlety of UI design but I
still hope the market is big enough for both of us. It’s
great to see smaller dev companies successful in an
Adobe world so I wish them continued success.

What about Illustrator? Do you see Affinity Designer
replacing Illustrator for some professional designers?
Does your vision extend to the full range of Affinity
apps eventually competing against the Adobe
Creative Suite as a whole?
Illustrator covers many use cases and some of them
very well. I can see Affinity replacing most of those
use cases over time but it may take many years
before we can say we have completely replaced
Illustrator. Illustrator doesn’t have many fans; people
mainly use it because they have to so offering an
alternative is very attractive to those users. Adobe
Creative Cloud Suite is very comprehensive with
Photoshop being the heart of the range, but I believe
Affinity Photo will chip away at its success and
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establish our competitiveness with the suite. I don’t
think people will actually talk about Affinity as a true
competitor until we have released Publisher and
show how all these applications work together in
way that I believe is a game changer.

can’t believe it took me so long to convert to a Mac
and I won’t be going back anytime soon. A few guys
in the team have MacBook Pros and I must admit
the screens are just amazing but I still prefer the
larger screen on my iMac.

Everyone on the team is dying to work on Affinity for
the iPad. The project started out targeting the iPad
so most of the work is already done but the UI and
some hardware acceleration is what will take the
time.

As for software I admire other than Affinity then it
would have to be Photoshop. It might sound like an
odd choice as I think the usability is often very poor
but from an engineering point of view it’s a great
achievement. Photoshop almost created an industry
and its creator Thomas Knoll inspired me to focus on
the details and the technology required to create
truly great applications.

Finally, what hardware and software do you all use
and/or admire?

Tony Brightman, along with the rest of the Affinity
developers, are active on the Affinity Forums.

Any plans for Affinity for iPad?

My current dev machine is an iMac and it’s been a
100% pleasure to use. It’s as fast as the first day I
used it 3 ½ years ago and is still going strong. Most
Windows PCs I have used slow down to a point of
being unusable or just break in some terrible way. I
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FEATURE FOCUS

The Pen Tool is one of the most important
tools to master in vector drawing.
Understanding the Pen Tool means
understanding nodes, tangents and curves –
the building blocks of all vector design work.
Here you’ll learn the most important
aspects of how the Pen Tool works in
Affinity Designer. Take note of the
basics, and get to grips with the
keyboard modifiers. Then get
practising!

Pen Tool
Tool shortcut:

FEATURE FOCUS | Pen tool

The Basics

Starting and ending a curve
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The Basics

Nodes and Tangents
When just single clicking with the Pen Tool, that produces nodes known as sharp cusps – this is effectively
when the line drawn between the two nodes is straight. On top of this nodes can also take on a tangent
property – which gives the ability to add and control curved lines. Nodes have 3 main forms:
Smooth Node
(Whole Tangent)

Cusp Node
(Split Tangent)

Sharp Cusp Node
(No Tangent)

Notice that a smooth node is depicted by a circle, and a cusp node (either with a split tangent or no
tangent at all) is depicted by a square. The pen tool gives you complete control over creating these
different types of nodes while drawing, as covered in the next couple of pages.
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The Basics

Drawing Smooth Nodes
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The Basics

Switching to the Node Tool

43

FEATURE FOCUS

FEATURE FOCUS | Pen tool

Advanced Techniques
To improve your workflow

To get the maximum productivity from the Pen Tool it’s also important to learn and use other
modifiers and options. To set you on your way over the coming pages we’ll look at:

• Using the Alt modifier to create split tangent cusps
• Using the Alt modifier to delete a tangent
• Using the Shift modifier to constrain your angles
• Snapping options available while using the Pen Tool
• Other Pen Tool modes
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Advanced Techniques

Using Alt to create split tangent cusps
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Advanced Techniques
Using Alt to delete a tangent

46

FEATURE FOCUS | Pen tool

Advanced Techniques
Using Shift to constrain
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Advanced Techniques
Node Snapping
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Advanced Techniques
Smart and Line Pen Modes
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TUTORIAL

In this tutorial Sascha Preuß (aka
bubblefriends) walks us through
creating a piece of his work with
Affinity Designer. From the first
sketches to the perfect picture he
explains every step in detail – and
he also gives you some hints on
how to do it best...

bubblefriends
meets Affinity
Designer

TUTORIAL | bubblefriends

Step 1 - Create Concept
Everything starts with a normal pencil and paper for
me, I always start my artworks by drawing small
thumbnail sketches. Thumbnail sketches allow me to
jot down ideas as small sketches that are not too
detailed and indicate shapes and composition with
soft lines.
Don't forget to have fun and let yourself be inspired.
If I like one of these scribbles, I draw it again larger
with more detail.
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Step 2 - Composition
When considering composition, I try to lead the
viewer’s eye along the most important parts of the
picture. I use a climbing diagonal from the bottom
left and emphasize it so that the uppermost element
of the picture, in this case a ball, seems to be lifted
up.
Both horsemen on the left make up the
counterweight. The cowboy who enters the scene
from the right hand side creates some more
movement and pushes the viewer’s eye back to the
diagonal again.
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The single elements of the picture are of different
sizes. I use the design principle ‘guest-host-servant’
in my work. The guest is the biggest element, the
host is smaller and the servant smallest. This
variation makes the composition more interesting.
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Step 3 - Create Sketch
This is the last version of the drawing. For this
tutorial I have drawn it again on an illuminated desk.
If I work with vectors I always make sure that the
composition is set. That means that the drawing has
to be rather detailed. In my opinion the quality of the
drawing is decisive for the quality of the finished
vector artwork. Scan the drawing using the following
settings: Greyscale | 300dpi | TIFF or JPG.
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Step 4 - Get Started in Affinity
Designer
Let's start vectorising the drawing in Affinity
Designer.
Open Affinity Designer and create a new
document (File > New or use the shortcut ⌘N).
You can see the settings I have used in the New
Document dialog shown. Click OK.
Select the Place Image Tool and select the
sketch. Click OK.
Drag the sketch
onto your canvas
and scale and
position as
required.
Lock this layer on
your Layers panel.

TIP: I work with CMYK as a colour format as I produce
my works to print them afterwards.
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Step 5 - Consider Your Workflow
Before I start I think about the sequence of the elements. What has to be placed in the background? Now I
begin to vectorise my drawing by redrawing the outlines in Affinity Designer, ensuring each figure and element
is on its own top-level layer and is drawn in order. I will think about adding colour and shading later.

1

2

3

4

TIP: To create a new layer, select Add Layer from the Layers panel.
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Step 6 - Working with Layers and Drawing with the Pen Tool
In Affinity Designer the layers can be compared with drawers and the Layers panel would then be the cupboard.
I can place single vectors in those drawers and then the whole drawer back into the cupboard.
I’m going to start with the figures that have a prism shaped head, and I am going to create a new layer for
them. I will draw them with the Pen Tool, the most important tool for me and the one I use most frequently.
With the Pen Tool you can place nodes which are connected with changeable lines.
There are 3 modes for the Pen Tool: Pen Mode, Smart Mode and Line Mode. I use the default Pen Mode, but
let’s go through each mode in turn.
Pen Mode: The most powerful
and precise mode used to
create bézier lines and shapes
with smooth or sharp corners
and nodes.

Smart Mode: Easily create
flowing lines and shapes by
clicking and placing nodes.

Line Mode: Used to draw
straight lines with sharp
nodes and shapes with
straight edges.

TIP: The Pen Tool has its own context toolbar for updating settings such as line width. Have a play around with
this, the best results are sometimes from trial and error! For this artwork I have used a 0.25pt line width to
draw my outlines.
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I follow the shapes and lines of my original drawing with the Pen Tool. I try not to place too many nodes to keep
the paths simple. You can click on any node and pull the corners to make them more rounded.
TIP: You can refine your curves and corners using the Node Tool. To convert a sharp corner to a smooth corner,
select the node and choose the Convert > Smooth option on the context toolbar.
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Step 7 - Using Shape and Geometry Tools
Draw the basic pyramid shape of the head using the Pen Tool. Then, draw the frontside triangle shape. Copy
(⌘C) and paste (⌘V) the first shape your drew. Select this new shape and the second shape you have drawn
and use Geometry Tools > Intersect to create your final head shape.
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For the head of the main figure of my picture I used the Ellipse Tool. To create the curves for e.g. the hat, hold
Shift when dragging with the Ellipse Tool to create a circle. Fit the ellipse to the lines of the pencil sketch using
the Move Tool. Repeat this action with a second circle. Select both circles and choose Divide from the Geometry
Tools. Delete the superfluous parts.
TIP: If you want to change single nodes of a shape, select the shape with the Move Tool and then choose Layer >
Convert to Curves. Now you can edit the points with the Node Tool.
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Continue until you have drawn all your outlines.
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Step 8 - Working with Colour and Swatches
Now its time to add some colour! In Affinity Designer you mix and apply
your colours using the Colour panel. I use the CMYK sliders on the Colour
panel to apply colour so that my artwork is print ready.
If you’re not sure whether to use CMYK (cyan, magenta, yellow, and black)
or RGB (red, green, blue) for the colour on your illustrations, remember
that CMYK should be used on illustrations where you want the end result
to be printed and RGB when you want to display your illustration digitally.

TIP: I use the following formula for colour perspective. Cold colours like blue, violet and bluish green should be used for the
background. Warm colours like yellow, red and earth colours get more attention in the foreground.

Define Swatches so that you do not have to mix all
colours again. To do this, mix a colour with the sliders on
the Colour panel, then switch to the Swatches panel.
Choose the palette 'Unnamed'. Click on the artist’s palette
on the right and the colour is now added. You can and
should give it a name (Rename Palette).
Now when clicking a vector shape you can colour
consistently by clicking on one of the swatches.
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Colour all the shapes in your
illustration.
Once again you start in the
background. After you’ve set the
outlines (strokes) to have no
colour, you can see if the object
fills are high enough contrast on
their own. If they’re not, update
your palette and revise them.
TIP: Select the Edit All Layers
option in the Layers panel so all
shapes can be edited without
having to select each layer first.
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Step 9 - Opacity
The background ‘rings’ should be white. Set the
transparency of the objects in the Layers panel with
the Opacity sliders. I find 40% - 60% are values that
work for me.
I have shown the opacity values I have used
throughout the illustration.
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Step 10 - Colour Gradients
The next step is to add colour gradients. I use them
to increase the plasticity of the figures. The source of
light helps decide how to use gradients to define
shading. Depending on where the source of light is
you have to define the colour gradients and the
shades. That's just a guideline, as the picture is not
meant to be realistic like a photograph. The
elements near the source of light should be brighter
than those far away. In this picture the source of
light is the ball on the top right.
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In Affinity Designer you add
colour gradients using the
Gradient Tool.
In the context toolbar you can choose
from the following gradient types:
Solid, Linear, Elliptical, Radial, and
Conical. You can also change the
colours and opacity of gradients.
Choose an element with the Move
Tool, then select the Gradient Tool. Pull
your cursor along your element you
want to apply a gradient to. A blue line
with two endpoints appears. It shows
the direction of the gradient and its
colours.
If you click on the nodes of the fill path
you can update the colour. You can do
this by using the Colour panel or using
the options on the Gradient toolbar.
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Step 11 - Shading & Shadows
Let’s look at creating shading – the video here shows a shaded element of the cowboy hat to help explain. In
this first example, I have used the following steps:
1. Draw the shape of your shaded
element with the Pen Tool
(using the Node Tool to adjust).
2. Apply a lighter colour than the
object it will shade.
3. Apply a linear gradient fill using
the Gradient Tool, with no
colour fill at the top of the
gradient.
4. Apply a Gaussian Blur (using
the Effects panel) with a radius
of 7.2px.
5. Set the layer mode to Multiply
on the Layers panel.

68

TUTORIAL | bubblefriends

Adding Shadows
Now let’s look at the arm of the cowboy figure to see how we have
added shadows. There are two kinds of shadows on this element, let’s
look at the foreground shadow first.
1. Take the arm base shape (the purple shape), and copy and paste it
(⌘C then ⌘V). Using the Move
Foreground shadow
Tool, move your copied shape away
from the area of the arm.
2. Give your copied shape a black
colour fill (C0,Y0,M0,K100) and set
the layer opacity to 50% and the
layer mode to Multiply.
3. Paste the purple shape again (⌘V)
and position it on top of the black
shape, ensuring it is slightly higher.
4. Select the two shapes and choose
the Subtract option on the
Geometry toolbar.
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Drop Shadows
The cowboy’s arm
also has a drop
shadow applied.
I did this by
following these
steps.

1. Take the arm
base shape (the
purple shape), and copy and paste it (⌘C then ⌘V). Using the Move Tool, move your copied shape away
from the area of the arm.
2. Give your copied shape a black colour fill (C0,Y0,M0,K100) and set the layer opacity to 58% and the layer
mode to Multiply. Apply a Gaussian Blur with a radius of 6.1px in the Effects panel.
3. Move the ‘shadow’ shape behind the arm shape using the Arrange tools – you now have your drop shadow!
TIP: You can also use the shadow effects available in the Effects Panel.
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In the exploded view you can see all the elements that make up
the cowboy, with all the shading and shadows.
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And here is my final illustration!
I hope this tutorial has been useful to you, here are a
couple more tips from me to get the most out of
Affinity Designer:

TIP: To erase effects and gradients later,
choose Reset document defaults.

TIP: When you choose a tool, Affinity Designer
shows you how to get started with that tool at the
bottom of the workspace.
TIP: When you point the cursor on a tool, Affinity shows
you a tool tip giving you the name of the tool and the
shortcut in brackets. For a more visual guide, check out our
Pen Tool Feature Focus in this issue of Affinity Review.

> Visit bubblefriends.de to see more of Sascha’s
work.
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Paolo Limoncelli is a UI/UX designer and
the master of creating brushes. He has
made this incredible set of FREE
BRUSHES under his DAUB umbrella DAUB Vector Set Vol. 1. exclusively for
Affinity Designer.
Check them out and see how to
get them and import them...

DAUB
Vector Set
Vol 1

NEW CONTENT

NEW CONTENT | DAUB Vector Set Vol 1
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How to install your brushes:
1. Download the DAUB - Vector Set Vol. 1.afbrushes
from here.
2. Open Affinity Designer.
3. Make sure you are in Draw Persona.
4. Go to the Brush panel, click the hamburger menu
and select Import Category... from the drop-down
list.
5. Browse to the DAUB - Vector Set Vol. 1.afbrushes
in your Downloads.
6. Thats it! Enjoy your new brushes!
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Handy keyboard shortcut cheat
sheets for Affinity Designer.
You can also download PDF
versions of these here.

Keyboard
Shortcuts

KEYBOARD SHORTCUTS

OPERATIONS
Rotate in 15° intervals
Rotate around opposite corner
Cancel a sizing, moving, or creating operation

⇧drag
⌃(ctrl) drag
esc

Resize vector objects, maintaining aspect ratio

⇧drag from a corner handle

Resize an object from its center

⌘drag from a corner handle

Mirror shearing

⌘drag

Constrain the movement of an object horizontally or vertically

⇧drag

Select multiple objects

⇧click

Select overlapped objects

⌥click

Edit line or brush strokes as you draw/paint

⌘

Creates cusp node for sharper corners

⌥drag control handle

Snap a line's direction nodes to 45° intervals

⇧drag control handle

Increase/decrease brush width
Hot key panning
Switch between Line/Colour 1 and Fill/Colour 2 swatch selectors (Colour and Swatches panels)

][
Spacebar
X

KEYBOARD SHORTCUTS

FILE

EDIT

OBJECT CONTROL

New Document

⌘N

Undo

⌘Z

Open Document

⌘O

Redo

⇧⌘Z

Ungroup

Close Document

W

Paste Style

⇧⌘V

Duplicate

Switch Document
Save
Save As
Print

⌃ctrl➝
⌘S
⇧⌘S
⌘P

Paste Without Format
Paste Inside
Line Break
Non Breaking Space
Soft Hyphen
Non Breaking Hyphen

WORKSPACE
Show/hide Studio

⇧⌘H

Show/hide Toolbar

⌥⌘T

⌥⇧⌘V

Group

Move to Front

⌘G
⇧⌘G
⌘J
⇧⌘]

Move Forward One

⌘]

⌃ctrl↵

Move to Back ⇧

⌘[

⌥spacebar

Move Back One

⇧⌘[

⌥⌘V

⌥
⌥⇧-

Lock

⌘L

Unlock

⇧⌘L

New Pixel Layer

⇧⌘V

KEYBOARD SHORTCUTS

TEXT
Bigger Text (when selected)
Smaller Text

⇧⌘=
⇧⌘-

Underline

⌘U

Superscript

^(ctrl)⌘+

Tighten

⌥←

Subscript

^(ctrl)⌘–

Loosen

⌥→

Align Left

⌘{

Tighten More

⌥⌘←

Align Center

⌘|

Loosen More

⌥⌘→

Align Right

⌘}

⌘T

Justify Left

⌥⌘|

Show Character
Show Typography

⇧⌘T

Bold

⌘B

Italic

⌘I

Special Characters
Spelling Options

^(ctrl)⌘spacebar
⇧⌘;

KEYBOARD SHORTCUTS

VIEW

SELECTIONS

Zoom In

⌘+

Select All

⌘A

Zoom Out

⌘–

Deselect

⌘D

Zoom to Fit

⌘0

Invert

Zoom to Selection
(Zoom to) 100%

⇧⌘0
⌘1

(Zoom to) Print Size

⌘8

(Zoom to) Pixel Size

⌘9

Pan Tool
Scroll Vertically

Add to Selection

H
Mouse scroll wheel

Scroll Horizontally

⇧(key)Mouse scroll wheel

Toggle Full Screen

^(ctrl)⌘F

Remove from
Selection

⎇ (Marquee and Free Hand
Selection tools)

Hide Affinity Designer
Hide Others (applications)
Minimize Window

⌘;

Media Browser

Show Grid

⌘’

Curves (Adjustment)

⌘R

^(ctrl) (Marquee and Free
Hand Selection tools)

MISC

Show Guides

Show Rulers

⇧⌘I

Black & White (Adjustment)

⌘H
⌥⌘H
⌘M
⇧⌘M
⌘M
⌥⇧⌘M

COMPETITIONS

We launched the #AffinityCat
competition at the end of October.
Find out what it was all about, and
who won...

#AffinityCat
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It all started with one of the cat themed ‘Easter Eggs’ in Affinity Designer...
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The Competition
We asked you all to submit a new design of a Affinity Cat on Facebook, Twitter and our forums using the
hashtag #AffinityCat.

The Rules
1. It must be a cat.
2. It must be a single shape.
3. It must be made in Affinity Designer
4. It had to be submitted before the end of Monday 3rd November 2014

The Prize
IntuosPro

The Entries
We had around 100 entries, even though Facebook was playing tricks on us with our hashtags ;). We enjoyed
looking through every single one, you guys did us proud!
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Here are some of the
entries which we felt
deserved a special
mention...
by Joshua
Pomeroy

‘Grumpy Cat’ by Ian Up

‘Cat Stevens’
by Ricky Plows

‘Schrodinger's cat’ by
Stephen Wildish
by honey honey
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And the winner was... (drum roll!)...
Tefy Estevez Rousseau, with this beauty!
Tefy’s Affinity Cat will be available in an
upcoming update to Affinity Designer.

Keep an eye out for upcoming Affinity
competitions for your chance to win!
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We hope you enjoyed reading Affinity Review!
Follow us on social media to keep up to date and
to hear about future issues, future products,
new developments and updates.

twitter.com/macaffinity

instagram.com/macaffinity

facebook.com/MacAffinity

macaffinity.tumblr.com

